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BÀI 9 - BÁO CÁO VÀ KẾT XUẤT BÁO CÁO
- Báo cáo là hình thức thích hợp nhất khi cần tổng hợp, trình bày và in dữ liệu theo khuôn dạng.
- Lợi ích của báo cáo:
+ Thể hiện được sự so sánh, tổng hợp và tính tổng theo nhóm các tập hợp dữ liệu lớn.
+ Trình bày nội dung văn bản (hóa đơn, đơn đặt hàng, nhãn thư, báo cáo, …) theo mẫu quy định
* Để tạo báo cáo bằng thuật sĩ tao thực hiện như sau:
B1: nháy đúp chuột vào Create report by using Wizard.
B2: Trong hộp thoại Report Wizard (H.47) chọn thông tin đưa vào báo cáo:
+ Chọn bảng hoặc mẫu hỏi trong mục Tables/Queries.
+ Chọn lần lượt các trường cần thiết từ ô Available Fields sang ô Selected Fields  bằng cách nháy đúp vào tên trường.
VD: Trong bảng HOC_SINH ta chọn 3 trường Ten, Toan, To.
+ Nháy Next để sang bước tiếp theo.
B3: Chọn trường để gộp nhóm trong báo cáo rồi nháy Next.
VD: Nháy đúp vào trường TO để nhóm theo tổ ( H. 48). 
B4: Chỉ ra (các) trường để sắp xếp thứ tự các bản ghi.
+ Ta sẽ sắp xếp HOTEN theo bảng chữ cái (H. 49a). 
+ Để tính điểm trung bình điểm Toán theo tổ ta nháy chuột vào Summary Options rồi tích vào Avg tương ứng với trường Toan.
+ Nháy OK.
+ Nháy Next.
B5: Chỉ ra cách bố trí các bản ghi và các trường trên báo cáo cũng như chọn kiểu trình bày cho báo cáo. Nháy Next để tiếp tục.
B6:  
- Đặt tên cho báo cáo trong ô What title do you want for your report (H. 50).
- Chọn một trong hai tùy chọn :
+ Xem báo cáo (Preview the report).
+ Sửa đổi thiết kế báo cáo (Midify the report’s design).
- Nháy Finish để kết thúc việc tạo báo cáo.



Bài 10. CỞ SỞ DỮ LIỆU QUAN HỆ
1. Mô hình dữ liệu:
· Cấu trúc dữ liệu.
· Các thao tác và các phép toán trên dữ liệu.
· Các ràng buộc dữ liệu.
a. Khái niệm: Mô hình dữ liệu là một tập các khái niệm, dùng để mô tả CTDL, các thao tác dữ liệu, các ràng buộc dữ liệu của một CSDL.
b. Các loại mô hình dữ liệu
· Mô hình DL hướng đối tượng
· Mô hình DL quan hệ
Mô hình dữ liệu phân cấp
2. Mô hình dữ liệu quan hệ:
+ Về mặt cấu trúc dữ liệu được thể hiện trong các bảng. Mỗi bảng thể hiện thông tin về một loại đối tượng (một chủ thể) bao gồm các hàng và các cột. Mỗi hàng cho thông tin về một đối tượng cụ thể (một cá thể) trong quản lí.
+ Về mặt thao tác trên dữ liệu: có thể cập nhật dữ liệu như : thêm, xóa hay sửa bản ghi trong một bảng.
+ Về mặt ràng buộc dữ liệu: dữ liệu trong một bảng phải thỏa mãn một số ràng buộc. Chẳng hạn, không được có hai bộ nào trong một bảng giống nhau hoàn toàn; với sự xuất hiện lặp lại của một số thuộc tính ở các bảng, mối liên kết giữa các bảng được xác lập. Mối liên kết này thể hiện mối quan hệ giữa các chủ thể được CSDL phản ánh.
3.Cơ sở dữ liệu quan hệ:
a. Khái niệm: 
CSDL được xây dựng trên mô hình dữ liệu quan hệ gọi là CSDL quan hệ. Hệ QTCSDL dùng để tạo lập, cập nhật và khai thác CSDL quan hệ gọi là hệ QTCSDL quan hệ.
b. Ví dụ:
(các ví dụ trong SGK86 – 87)
c. Khóa và liên kết giữa các bảng:
· Khóa: của một bảng là một tập thuộc tính gồm một hay một số thuộc tính của bảng có hai tính chất:
· Không có 2 bộ khác nhau trong bảng có giá trị bằng nhau trên khóa.
· Không có tập con thực sự nào của tập thuộc tính này có tính chất trên.
· Khoá chính:
Một bảng có thể có nhiều khóa. Trong các khóa của một bảng người ta thường chọn (chỉ định) một khóa làm khóa chính.
Khi nhập dữ liệu cho một bảng, giá trị của mọi bộ tại khóa chính không được để trống.

§11. CÁC THAO TÁC VỚI  CƠ  SỞ  DỮ  LIỆU  QUAN HỆ (TT2)


1. Tạo lập CSDL
* Tạo bảng:
Để tạo một bảng ta cần phải khai báo cấu trúc bảng bao gồm các bước:
- Đặt tên trường.
- Chỉ định kiểu dữ liệu cho trường.
- Khai báo kích thước của trường.
Một ví dụ về giao diện để tạo bảng như trong hình 75.
+ Chọn khóa chính cho bảng bằng cách để hệ QTCSDL tự động chọn hoặc ta xác định khóa thích hợp trong các khóa làm khóa chính.
+ Đặt tên bảng và lưu cấu trúc bảng.
+ Tạo liên kết bảng.
2. Cập nhật dữ liệu
- Phần lớn các hệ QTCSDL cho phép tạo ra biểu mẫu nhập dữ liệu Hình.76 để làm cho công việc nhập dữ liệu trở nên dễ dàng hơn, nhanh hơn và hạn chế bớt khả năng nhầm lẫn.
- Dữ liệu nhập vào có thể được chỉnh sửa, thêm, xóa.
+ Thêm bản ghi bằng cách bổ sung một hoặc một vài bộ dữ liệu vào bảng.
+ Chỉnh sửa dữ liệu là việc thay đổi các giá trị của một bộ mà không phải thay đổi toàn bộ giá trị các thuộc tính còn lại của bộ đó.
+ Xóa bản ghi là việc xóa một hoặc một số bộ của bảng.
3.Khai thác CSDL:
      a.  Sắp xếp các bản ghi :
Một trong những việc mà một hệ QTCSDL thường phải thực hiện là khả năng tổ chức hoặc cung cấp phương tiện truy cập các bản ghi theo một trình tự nào đó. Ta có thể hiển thị trên màn hình hay in ra các bản ghi theo trình tự này. Các bản ghi có thể được sắp xếp theo nội dung của một hay nhiều trường.
b. Truy vấn CSDL:
Truy vấn là một phát biểu thể hiện yêu cầu của người sử dụng. Truy vấn mô tả các dữ liệu và đặt các tiêu chí để hệ QTCSDL có thể thu thập dữ liệu thích hợp. Nói một cách khác, đó là một dạng bộ lọc, có khả năng thu thập thông tin từ nhiều bảng trong một hệ CSDL quan hệ.
Để phục vụ được việc truy vấn CSDL, thông thường các hệ QTCSDL cho phép nhận các biểu thức hay các tiêu chí nhằm các mục đích sau:
+ Định vị các bản ghi.
+ Thiết lập mối quan hệ hay các liên kết giữa các bảng để kết xuất thông tin.
+ Liệt kê một tập con các bản ghi.
+ Thực hiện các phép toán.
+ Xóa một số bản ghi.
+ Thực hiện các thao tác quản lí dữ liệu khác.
c. Xem dữ liệu
Thông thường các hệ QTCSDL cung cấp nhiều cách xem dữ liệu.
+ Xem toàn bộ bảng.
+ Có thể dùng công cụ lọc dữ liệu để xem  một tập con các bản ghi hoặc một số trường trong bảng.
+ Các hệ QTCSDL quan hệ quen thuộc cũng cho phép tạo ra các biểu mẫu để xem các bản ghi.
d. Kết xuất báo cáo
Trông tin trong một báo cáo được thu thập bằng cách tập hợp dữ liệu theo các tiêu chí do người sử dụng đặt ra. Báo cáo thường được in ra hay hiển thị trên màn hình theo khuôn mẫu định sẵn. Cũng như các biểu mẫu, các báo cáo có thể xây dựng dựa trên các truy vấn. 


§12. CÁC LOẠI KIẾN TRÚC CỦA HỆ CƠ SỞ DỮ LIỆU
1. Các hệ CSDL tập trung
Với hệ CSDL tập trung, toàn bộ dữ liệu được lưu trữ tại một máy hoặc một dàn máy. Những người dùng từ xa có thể truy cập vào CSDL thông qua các phương tiện truyền thông dữ liệu. Nói chung có ba kiểu kiến trúc tập trung:
a. Hệ CSDL cá nhân
b. Hệ CSDL trung tâm
c. Hệ CSDL khách - chủ
2. Các hệ CSDL phân tán
a. Khái niệm CSDL phân tán
- CSDL phân tán là một tập hợp dữ liệu có liên quan (về logic) được dùng chung và phân tán về mặt vật lí trên một mạng máy tính.
Một hệ QTCSDL phân tán là một hệ thống phần mềm cho phép quản trị CSDL phân tán và làm cho người sử dụng không nhận thấy sự phân tán về lưu trữ dữ liệu.
b. Một số ưu điểm và hạn chế của các hệ CSDL phân tán
Sự phân tán dữ liệu và các ứng dụng có một số ưu điểm so với các hệ CSDL tập trung:
+ Cấu trúc phân tán dữ liệu thích hợp cho bản chất phân tán của nhiều người dùng.
+ Dữ liệu được chia sẻ trên mạng nhưng vẫn cho phép quản trị dữ liệu địa phương (dữ liệu đặt tại mỗi trạm)
+ Dữ liệu có tính sẵn sàng cao.
+ Dữ liệu có tính tin cậy cao vì khi một nút gặp sự cố, có thể khôi phục được dữ liệu tại đây do bản sao của nó có thể được lưu trữ tại một nút khác nữa.
+ Hiệu năng của hệ thống được nâng cao hơn.
+ Cho phép mở rộng các tổ chức một cách linh hoạt. Có thể thêm nút mới vào mạng máy tính mà không ảnh hưởng đến hoạt động của các nút sẵn có.
So với các hệ CSDL tập trung, hệ CSDL phân tán có một số hạn chế như sau:
+ Hệ thống phức tạp hơn vì phải làm ẩn đi sự phân tán dữ liệu đối với người dùng.
+ Chi phí cao hơn.
+ Đảm bảo an ninh khó khăn hơn.
+ Đảm bảo tính nhất quán dữ liệu khó hơn.
+ Việc thiết kế CSDL phân tán phức tạp hơn


§13. BẢO MẬT THÔNG TIN TRONG CÁC HỆ CSDL
1. Chính sách và ý thức:
- Ở cấp quốc gia, bảo mật phụ thuộc vào sự quan tâm của chính phủ trong việc ban hành các chủ trương, chính sách, điều luật qui định của nhà nước.
- Người phân tích, thiết kế và người QTCSDL phải có các giải pháp tốt về phần cứng và phần mềm thích hợp.
- Người dùng phải có ý thức bảo vệ thông tin.
2. Phân quyền truy cập và nhận dạng người dùng
Bảng phân quyền truy cập:
	
	Mã HS
	Các điểm số
	Các thông tin khác

	K10
	Đ
	Đ
	K

	K11
	Đ
	Đ
	K

	K12
	Đ
	Đ
	K

	Giáo viên
	Đ
	Đ
	Đ

	Người Qt
	ĐSBX
	ĐSBX
	ĐSBX



- Người QTCSDL cần cung cấp:
· Bảng phân quyền truy cập cho hệ CSDL.
· Phương tiện cho người dùng hệ QTCSDL nhận biết đúng được họ.
- Người dùng muốn truy cập vào hệ thống cần khai báo:
· Tên người dùng.
· Mật khẩu.
Dựa vào hai thông tin này, hệ QTCSDL xác minh để cho phép hoặc từ chối quyền truy cập CSDL.
Chú ý:
· Đối với nhóm người truy cập cao thì cơ chế nhận dạng có thể phức tạp hơn.
Hệ QTCSDL cung cấp cho người dùng cách thay đổi mật khẩu, tăng cường khả năng bảo vệ mật khẩu


BÀI TẬP V À  THỰC HÀNH 
Câu 1 Tạo một tệp CSDL có tên THIHK1.MDB lưu tại thư mục My Computer, thiết kế 3 Tables như sau được mô tả ở phía dưới:
	Tên bảng
	Tên trường
	Khóa chính
	Kiểu dữ liệu
	Ghi chú

	HOC_SINH
	Ma_hoc_sinh
Ho_dem
Ten
	
	Text
Text
Text
	

	MON_HOC
	Ma_mon_hoc
Ten_mon_hoc
	
	Text
Text
	

	BANG_DIEM

	ID
Ma_hoc_sinh
Ma_mon_hoc
Ngay_kiem_tra
Diem_so
	
	AutoNumber
Text
Text
Date/Time
Number 
	Ở thuộc tính Field Size chọn Single (số thực)
Format:Fixed
Decimal place:1


Câu 2Thiết lập mối quan hệ giữa bảng HOC_SINH với BANG_DIEM qua trường Ma_hoc_sinh, giữa bảng MON_HOC với BANG_DIEM qua trường Ma_mon_hoc để đảm bảo tính toàn vẹn dữ liệu
Câu 3: Nội dung dữ liệu nhập vào cho các bảng như sau:
[image: ]

[image: ]  [image: ]
Câu 4: Tạo biểu mẫu để nhập dữ liệu cho bảng 2 bảng một lần: HOC_SINH và BANG_DIEM (form chính và phụ)
Câu 5 : Thiết kế một số mẫu hỏi theo yêu cầu sau đây:
a) Thống kê (điểm trung bình, điểm cao nhất, điểm thấp nhất ) theo từng học sinh trong lớp. Danh sách hiển thị học sinh theo 05 cột: họ đệm, tên, cột điểm trung bình, cột điểm cao nhất, cột điểm thấp nhất. Đặt tên Q1
b) Thống kê theo từng môn học, trên trường điểm, để biết trị trung bình, cao nhất, thấp nhất . Danh sách hiển thị 04 cột:  tên môn học, và 3 cột  thống kê. Đặt tên Q2


ĐỀ CƯƠNG HỌC SINH TỰ ÔN TẬP
I. CÂU HỎI TRẮC NGHIỆM

BÀI 1: MỘT SỐ KHÁI NIỆM CƠ BẢN

Câu 1: Công việc thường gặp khi xử lí thông tin của một tổ chức là gì? 
A. Tạo lập hồ sơ	  B. Cập nhật hồ sơ	C. Khai thác hồ sơ	D. Tạo lập, cập nhật, khai thác hồ sơ
Câu 2: Việc lưu trữ dữ liệu đầy đủ và hợp lí sẽ:
A. Hỗ trợ thống kê, báo cáo, tổng hợp số liệu. 	B. Hỗ trợ ra quyết định
C. Cả A và B đều đúng				D. Cả A và B đều sai.
Câu 3: Cần tiến hành cập nhật hồ sơ học sinh của nhà trường trong các trường hợp nào sau đây?
A. Một học sinh mới chuyển từ trường khác đến; thông tin về ngày sinh của một học sinh bị sai.
B. Sắp xếp danh sách học sinh theo thứ tự tăng dần của tên
C. Tìm học sinh có điểm môn toán cao nhất khối.
D. Tính tỉ lệ học sinh trên trung bình môn Tin của từng lớp.
Câu 4: Dữ liệu trong một CSDL được lưu trong:
A. Bộ nhớ RAM	B. Bộ nhớ ROM 	C. Bộ nhớ ngoài	D. Các thiết bị vật lí
Câu 5: Việc xác định cấu trúc hồ sơ được tiến hành vào thời điểm nào?
A. Trước khi thực hiện các phép tìm kiếm, tra cứu thông tin	
B. Cùng lúc với việc nhập và cập nhật hồ sơ
C. Sau khi đã nhập các hồ sơ vào máy tính		
D. Trước khi nhập hồ sơ vào máy tính
Câu 6: Xét công tác quản lí hồ sơ. Trong số các công việc sau, những việc nào không thuộc nhóm thao tác cập nhật hồ sơ?
A. Xóa một hồ sơ				B. Thống kê và lập báo cáo	
C. Thêm hai hồ sơ				D. Sửa tên trong một hồ sơ.
Câu 7: Cơ sở dữ liệu (CSDL) là :
A. Tập hợp dữ liệu chứa đựng các kiểu dữ liệu: ký tự, số, ngày/giờ, hình ảnh... của một chủ thể nào đó.
B. Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được ghi lên giấy.
C. Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được lưu trên máy tính điện tử để đáp ứng nhu cầu khai thác thông tin của nhiều người.
D. Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được lưu trên giấy để đáp ứng nhu cầu khai thác thông tin của nhiều người.
Câu 8: Hệ quản trị CSDL là:
A. Phần mềm dùng tạo lập, cập nhật, lưu trữ và khai thác thông tin của CSDL
B. Phần mềm dùng tạo lập, lưu trữ một CSDL
C. Phần mềm để thao tác và xử lý các đối tượng trong CSDL
D. Phần mềm dùng tạo lập CSDL
Câu 9: Em hiểu như thế nào về cụm từ  “Hệ quản trị cơ sở dữ liệu” ?
A. Hệ quản trị cơ sở dữ liệu là một loại thiết bị hỗ trợ màn hình máy tính
B. Hệ quản trị cơ sở dữ liệu là một loại thiết bị hỗ trợ mạng máy tính
C. Hệ quản trị cơ sở dữ liệu là một loại dữ liệu được lưu trữ trên máy tính
D. Hệ quản trị cơ sở dữ liệu là một loại phần mềm máy tính
Câu 10: Một Hệ CSDL gồm:
A. CSDL và các thiết bị vật lí.	B. Các phần mềm ứng dụng và CSDL.
C. Hệ QTCSDL và các thiết bị vật lí.	D. CSDL và hệ QTCSDL quản trị và khai thác CSDL đó.
Câu 11: Hoạt động nào sau đây có sử dụng CSDL?
A. Bán vé máy bay				B. Quản lý học sinh trong nhà trường		
C. Bán hàng có quy mô			D. Tất cả đều đúng
Câu 12: Hãy nêu các ưu điểm khi sử dụng CSDL trên máy tính điện tử:
A. Gọn, thời sự (Cập nhật đầy đủ, kịp thời...)
B. Gọn, nhanh chóng
C. Gọn, thời sự, nhanh chóng, nhiều nguời có thể sử dụng chung CSDL
D. Gọn, thời sự, nhanh chóng
Câu 13: Khai thác hồ sơ gồm có những việc chính nào?
A. Sắp xếp, tìm kiếm	B. Thống kê, lập báo cáo	C. Sắp xếp, tìm kiếm, thống kê	D. Cả A và B
Câu 14: Xét tệp lưu trữ hồ sơ học bạ của học sinh, trong đó lưu trữ điểm tổng kết của các môn Văn, Toán, Lí, Sinh, Sử, Địa. Những việc nào sau đây không thuộc thao tác tìm kiếm?
A. Tìm học sinh có điểm tổng kết môn Văn cao nhất
B. Tìm học sinh có điểm tổng kết môn Toán thấp nhất
C. Tìm học sinh có điểm trung bình sáu môn cao nhất
D. Tìm học sinh nữ có điểm môn Toán cao nhất và học sinh nam có điểm môn Văn cao nhất
Câu 15: Xét tệp hồ sơ học bạ của một lớp. Các hồ sơ được sắp xếp giảm dần theo điểm trung bình của học sinh. Việc nào nêu dưới đây đòi hỏi phải duyệt tất cả các hồ sơ trong tệp?
A. Tìm học sinh có điểm trung bình cao nhất, thấp nhất
B. Tính điểm trung bình của tất cả học sinh trong lớp
C. Tính và so sánh điểm TB của các học sinh nam và điểm TB của các học sinh nữ trong lớp
D. Cả B và C
Câu 16: Sau khi thực hiện tìm kiếm thông tin trong một tệp hồ sơ học sinh, khẳng định nào sau đây là đúng?
A. Trình tự các hồ sơ trong tệp không thay đổi
B. Tệp hồ sơ có thể xuất hiện những hồ sơ mới
C. Trình tự các hồ sơ trong tệp không thay đổi, nhưng những thông tin tìm thấy đã được lấy ra nên không còn trong những hồ sơ tương ứng
D. Những hồ sơ tìm được sẽ không còn trên tệp vì người ta đã lấy thông tin ra
Câu 17: Những khẳng định nào sau đây là sai?
A. Tìm kiếm là việc tra cứu các thông tin không có sẵn trong hồ sơ thỏa mãn một số điều kiện nào đó
B. Thống kê là cách khai thác hồ sơ dựa trên tính toán để đưa ra các thông tin đặc trưng, không có sẵn trong hồ sơ
C. Lập báo cáo là việc sử dụng các kết quả tìm kiếm, thống kê, sắp xếp các bộ hồ sơ để tạo lập một bộ hồ sơ mới có nội dung và cấu trúc khuôn dạng theo một yêu cầu cụ thể nào đó, thường để in ra giấy
D. Sắp xếp hồ sơ theo một tiêu chí nào đó phù hợp với yêu cầu quản lý của tổ chức
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BÀI 2: HỆ QUẢN TRỊ CƠ SỞ DỮ LIỆU

Câu 1: Một hệ quản trị CSDL không có chức năng nào trong các chức năng dưới đây?
A. Cung cấp môi trường tạo lập CSDL
B. Cung cấp môi trường cập nhật và khai thác dữ liệu
C. Cung cấp công cụ quản lí bộ nhớ
D. Cung cấp công cụ kiểm soát, điều khiển truy cập vào CSDL.
Câu 2: Ngôn ngữ định nghĩa dữ liệu thật chất là:
A. Ngôn ngữ lập trình Pascal					B. Ngôn ngữ C
C. Các kí hiệu toán học dùng để thực hiện các tính toán	D. Hệ thống các kí hiệu để mô tả CSDL
Câu 3: Ngôn ngữ định nghĩa dữ liệu bao gồm các lệnh cho phép:
A. Đảm bảo tính độc lập dữ liệu
B. Khai báo kiểu dữ liệu, cấu trúc dữ liệu và các ràng buộc trên dữ liệu của  CSDL
C. Mô tả các đối tượng được lưu trữ trong CSDL
D. Khai báo kiểu dữ liệu của CSDL
Câu 4: Ngôn ngữ thao tác dữ liệu thật chất là:
A. Ngôn ngữ để người dùng diễn tả yêu cầu cập nhật hay khai thác thông tin
B. Ngôn ngữ để người dùng diễn tả yêu cầu cập nhật thông tin
C. Ngôn ngữ SQL
D. Ngôn ngữ bậc cao
Câu 5: Ngôn ngữ thao tác dữ liệu bao gồm các lệnh cho phép:
A. Nhập, sửa, xóa dữ liệu
B. Khai báo kiểu, cấu trúc, các ràng buộc trên dữ liệu của  CSDL
C. Khai thác dữ liệu như: tìm kiếm, sắp xếp, kết xuất báo cáo…
D. Câu A và C 
Câu 6: Ngôn ngữ CSDL được sử dụng phổ biến hiện nay là:
A. SQL			B. Access			C. Foxpro			D. Java
Câu 7: Những nhiệm vụ nào dưới đây không thuộc nhiệm vụ của công cụ kiểm soát, điều khiển truy cập vào CSDL?
A. Duy trì tính nhất quán của CSDL		B. Cập nhật (thêm, sửa, xóa dữ liệu)
C. Khôi phục CSDL khi có sự cố		D. Phát hiện và ngăn chặn sự truy cập không được phép
Câu 8: Hệ QT CSDL có các chương trình thực hiện những nhiệm vụ:
A. Phát hiện và ngăn chặn sự truy cập không được phép, tổ chức và điều khiển các truy cập đồng thời
B. Duy trì tính nhất quán của dữ liệu, quản lý các mô tả dữ liệu
C. Khôi phục CSDL khi có sự cố ở phần cứng hay phần mềm
D. Cả 3 đáp án A, B và C
Câu 9: Khẳng định nào sau đây là đúng?
A. Hệ QT CSDL là một bộ phận của ngôn ngữ CSDL, đóng vai trò chương trình dịch cho ngôn ngữ CSDL
B. Người lập trình ứng dụng không được phép đồng thời là người quản trị hệ thống vì như vậy vi phạm quy tắc an toàn và bảo mật
C. Hệ QT CSDL hoạt động độc lập, không phụ thuộc vào hệ điều hành
D. Người quản trị CSDL phải hiểu biết sâu sắc và có kĩ năng tốt trong các lĩnh vực CSDL, hệ QT CSDL và môi trường hệ thống
Câu 10: Người nào đã tạo ra các phần mềm ứng dụng đáp ứng nhu cầu khai thác thông tin từ CSDL?
A. Người dùng	B. Người  lập trình ứng dụng
C. Người QT CSDL	D. Cả ba người trên
Câu 11: Người nào có vai trò quan trọng trong vấn đề phân quyền hạn truy cập sử dụng CSDL?
A. Người lập trình	B. Người dùng
C. Người quản trị	D. Nguời quản trị CSDL
Câu 12: Trong vai trò của con người khi làm việc với các hệ CSDL, người thiết kế và cấp phát quyền truy cập cơ sở dữ liệu, là người ?
A. Người lập trình ứng dụng                        	B. Người sử dụng (khách hàng)
C. Người quản trị cơ sở dữ liệu     		D. Người bảo hành các thiết bị phần cứng của máy tính
Câu 13: Chức năng của hệ QTCSDL?
A. Cung cấp cách khai báo dữ liệu
B. Cung cấp môi trường tạo lập CSDL và  công cụ kiểm soát, điều khiển việc truy cập vào CSDL.
C. Cung cấp cách cập nhật dữ liệu, tìm kiếm và kết xuất thông tin
D. Câu B và C
Câu 14: Quy trình xây dựng CSDL là:
A. Khảo sát  Thiết kế  Kiểm thử			B. Khảo sát  Kiểm thử  Thiết kế
C. Thiết kế  Kiểm thử  Khảo sát			D. Thiết kế  Khảo sát  Kiểm thử
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BÀI 3: GIỚI THIỆU VỀ MICROSOFT ACCESS

Câu 1: Access là gì?
A. Là phần mềm ứng dụng	B. Là hệ QTCSDL do hãng Microsoft sản xuất
C. Là phần cứng	D. Cả A và B
Câu 2: Access là hệ QT CSDL dành cho:
A. Máy tính cá nhân	B. Các mạng máy tính trong mạng toàn cầu
C. Các máy tính chạy trong mạng cục bộ	D. Cả A và C
Câu 3: Các chức năng chính của Access?
A. Lập bảng	B. Tính toán và khai thác dữ liệu
C. Lưu trữ dữ liệu	D. Ba câu trên đều đúng
Câu 4: Access có những khả năng nào?
A. Cung cấp công cụ tạo lập, lưu trữ dữ liệu	
B. Cung cấp công cụ tạo lập, cập nhật và khai thác dữ liệu 
C. Cung cấp công cụ tạo lập, lưu trữ và khai thác dữ liệu
D. Cung cấp công cụ tạo lập, lưu trữ, cập nhật và khai thác dữ liệu 
Câu 5: Các đối tượng cơ bản trong Access là:
A. Bảng, Macro, Biểu mẫu, Mẫu hỏi	B. Bảng, Macro, Biểu mẫu, Báo cáo
C. Bảng, Mẫu hỏi, Biểu mẫu, Báo cáo	D. Bảng, Macro, Môđun, Báo cáo
Câu 6: Trong Access có mấy đối tượng cơ bản?
A. 4	B. 2	C. 3	D. 1
Câu 7: Chọn câu sai trong các câu sau:
A. Access có khả năng cung cấp công cụ tạo lập CSDL
B. Access không hỗ trợ lưu trữ CSDL trên các thiết bị nhớ.
C. Access cho phép cập nhật dữ liệu, tạo báo cáo, thống kê, tổng hợp.
D. CSDL xây dựng trong Access gồm các bảng và liên kết giữa các bảng.
Câu 8: Để định dạng, tính toán, tổng hợp và in dữ liệu, ta dùng:
A. Table	B. Form	C. Query	D. Report
Câu 9: Để sắp xếp, tìm kiếm và kết xuất dữ liệu xác định từ một hoặc nhiều bảng, ta dùng:
A. Table	B. Form	C. Query	D. Report
Câu 10: Đối tượng nào tạo giao diện thuận tiện cho việc nhập hoặc hiển thị thông tin?
A. Table	B. Form	C. Query	D. Report
Câu 11: Đối tượng nào có chức năng dùng để lưu dữ liệu?
A. Table	B. Form	C. Query	D. Report
Câu 12: Để khởi động Access, ta thực hiện:
A. Nháy đúp vào biểu tượng Access [image: ] trên màn hình nền
B. Nháy vào biểu tượng Access [image: ] trên màn hình nền
C. Start  All Programs  Microsoft Office  Microsoft Access
D. A hoặc C
Câu 13: Để tạo một CSDL mới và đặt tên tệp trong Access, ta phải:
A. Khởi động Access, vào File chọn New hoặc kích vào biểu tượng New
B. Vào File chọn New
C. Kích vào biểu  tượng New
D. Khởi động Access, vào File chọn New hoặc kích vào biểu tượng New, kích tiếp vào Blank DataBase, rồi đặt tên file và chọn vị trí lưu tệp, rồi sau đó chọn Create
Câu 14: Hãy sắp xếp các bước sau để được một thao tác đúng khi tạo một CSDL mới?
(1) Chọn nút Create    ( 2) Chọn File -> New      (3) Nhập tên cơ sở dữ liệu      (4) Chọn Blank Database
A. (2)  (4)  (3)  (1)   	B. (2)  (1)  (3)  (4)     
C. (1)  (2)  (3)  (4)	D. (1)  (3)  (4)  (2)
Câu 15: Trong Access, để tạo CSDL mới, thao tác thực hiện lệnh nào sau đây là đúng?
A. Create Table in Design View	B. Create table by using wizard
C. File/open	D. File/New/Blank Database
Câu 16: Tên của CSDL trong Access bắt buộc phải đặt trước hay sau khi tạo CSDL?
A. Đặt tên tệp sau khi đã tạo CSDL                  B. Vào File /Exit
C. Vào File /Close                                             D. Bắt buộc vào là đặt tên tệp ngay rồi mới tạo CSDL sau
Câu 17: Trong Acess, để mở CSDL đã lưu, thao tác thực hiện lệnh nào sau đây là đúng?
A. File/new/Blank Database	B. Create table by using wizard
C. File/open/<tên tệp>	D. Create Table in Design View 
Câu 18: Giả sử đã có tệp Access trên đĩa, để mở tập tin đó thì ta thực hiện thao tác nào mới đúng?
A. Nhấn tổ hợp phím CTRL+ O	B. Nháy đúp chuột lên tên của CSDL (nếu có) trong khung New File
C. File/Open	D. Cả A, B và C đều đúng
Câu 19: Kết thúc phiên làm việc với Access bằng cách thực hiện thao tác:
A. File/Close		B. Nháy vào nút (X) nằm ở góc trên bên phải màn hình làm việc của Access
C. File/Exit		D. Câu B hoặc C
Câu 20: Có mấy chế độ chính để làm việc với các loại đối tượng?
A. 5 chế độ	B. 3 chế độ		C. 4 chế độ		D. 2 chế độ
Câu 21: Hai chế độ chính làm việc với các đối tượng là:
A. Trang dữ liệu và thiết kế	B. Chỉnh sửa và cập nhật	
C. Thiết kế và bảng	D. Thiết kế và cập nhật
Câu 22: Chế độ thiết kế được dùng để:
A. Tạo mới hay thay đổi cấu trúc của bảng, mẫu hỏi; thay đổi cách trình bày và định dạng biểu mẫu, báo cáo
B. Cập nhật dữ liệu cho của bảng, mẫu hỏi; thay đổi cách trình bày và định dạng biểu mẫu, báo cáo
C. Tạo mới hay thay đổi cấu trúc của bảng, mẫu hỏi; hiển thị dữ liệu của biểu mẫu, báo cáo
D. Tạo mới hay thay đổi cấu trúc của bảng, mẫu hỏi, biểu mẫu và báo cáo
Câu 23: Chế độ trang dữ liệu được dùng để:
A. Tạo mới hay thay đổi cấu trúc của bảng, mẫu hỏi; thay đổi cách trình bày và định dạng biểu mẫu, báo cáo
B. Cập nhật dữ liệu cho của bảng, mẫu hỏi; thay đổi cách trình bày và định dạng biểu mẫu, báo cáo
C. Hiển thị dữ liệu của biểu mẫu, báo cáo; thay đổi cấu trúc bảng, mẫu hỏi
D. Hiển thị dữ liệu dạng bảng, cho phép xem, xóa hoặc thay đổi các dữ liệu đã có
Câu 24: Trong chế độ trang dữ liệu, ta có thể chuyển sang chế độ thiết kế bằng cách dùng menu:
A. Format→Design View		B. View→Design View 
C. Tools→Design View		D. Edit →Design View 
Câu 25: Để chuyển đổi qua lại giữa chế độ trang dữ liệu và chế độ thiết kế, ta nháy nút:
A. [image: ]			B. [image: ]			C. [image: ]	 hoặc [image: ]		D. [image: ]
Câu 26: Một đối tượng trong Access có thể được tạo ra bằng cách:
A. Người dùng tự thiết kế, dùng thuật sĩ hoặc kết hợp cả 2 cách trên	B. Người dùng tự thiết kế
C. Kết hợp thiết kế và thuật sĩ							D. Dùng các mẫu dựng sẵn
Câu 27: Để tạo một đối tượng trong Access, trước tiên ta phải nháy chọn một đối tượng cần tạo trong bảng chọn đối tượng, rồi tiếp tục thực hiện:
A. Nháy nút [image: ] …			
B. Nháy chọn  một trong các cách (tự thiết kế, dùng thuật sĩ, kết hợp giữa thuật sĩ và thiết kế) trong trang bảng
C. Đáp án A, B đều đúng
D. Đáp án A, B đều sai
Câu 28: Người ta thường sử dụng cách nào để tạo một đối tượng mới (table)?
A. Create table in Design view			B. Create table by using wizard
C. Create table by entering data			D. Create form in Design view 
Câu 29: Để mở một đối tượng, trong cửa sổ của loại đối tượng tương ứng, ta thực hiện:
A. Nháy lên tên một đối tượng rồi tiếp tục nháy nút [image: ] để mở nó	
B. Nháy lên tên một đối tượng để mở nó
C. Nháy đúp lên tên một đối tượng để mở nó	
D. Đáp án A hoặc C	
Câu 30: Phần đuôi của tên tập tin trong Access là
A. MDB		B. DOC		C. XLS			D. TEXT
Câu 31: MDB viết tắt bởi
A. Không có câu nào đúng	B. Manegement DataBase
C. Microsoft DataBase	D. Microsoft Access DataBase
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-------------------------------------------------------------------------------------------------------------------------------
BÀI 4: CẤU TRÚC BẢNG

Câu 1: Thành phần cơ sở của Access là:
A. Table	B. Field	C. Record	D. Field name
Câu 2: Trong Access, muốn làm việc với đối tượng bảng, tại cửa sổ cơ sở dữ liệu ta chọn nhãn :
A. Queries	B. Reports	C. Tables	D. Forms
Câu 3: Để mở một bảng ở chế độ thiết kế, ta chọn bảng đó rồi:
A. Click vào nút [image: ]	B. Bấm Enter
C. Click vào nút [image: ]	D. Click vào nút [image: ]
Câu 4: Trong các phát biểu sau, phát biểu nào sai?
A. Trường (field): bản chất là cột của bảng, thể hiện thuộc tính của chủ thể cần quản lý
B. Bản ghi (record): bản chất là hàng của bảng, gồm dữ liệu về các thuộc tính của chủ thể được quản lý
C. Kiểu dữ liệu (Data Type): là kiểu của dữ liệu lưu trong một trường
D. Một trường có thể có nhiều kiểu dữ liệu
Câu 5: Trong Access, một bản ghi được tạo thành từ dãy:
A.Trường		B.Cơ sở dữ liệu		C.Tệp			D.Bản ghi khác
Câu 6: Phát biểu nào sau là đúng nhất ?
A. Record  là tổng số hàng của bảng	B. Data Type là kiểu dữ liệu trong một bảng
C. Table gồm các cột và hàng	D. Field là tổng số cột trên một bảng
Câu 7: Trong Access, khi nhập dữ liệu cho bảng, giá trị của field GIOI_TINH là True. Khi đó field GIOI_TINH được xác định kiểu dữ liệu gì ?
A.Yes/No			B.Boolean			C.True/False		D.Date/Time
Câu 8: Khi chọn kiểu dữ liệu cho trường THÀNH_TIỀN (bắt buộc kèm theo đơn vị tiền tệ), phải  chọn loại nào?
A. Number	B. Currency	C. Text	D. Date/time
Câu 9: Khi chọn dữ liệu cho các trường chỉ chứa một trong hai giá trị như: trường “gioitinh”, trường  “đoàn viên”, ...nên chọn kiểu dữ liệu nào để sau này nhập dữ liệu cho nhanh.
A. Number	B. Text	C. Yes/No	D. Auto Number
Câu 10: Đâu là kiểu dữ liệu văn bản trong Access:
A. Character			B. String		C. Text			D. Currency
Câu 11: Chọn kiểu dữ liệu nào cho truờng điểm “Tóan”, “Lý”,...
A. AutoNumber	B. Yes/No	C. Number	D. Currency
Câu 12: Trong Access, dữ liệu kiểu ngày tháng được khai báo bằng:
A. Day/Type	B. Date/Type	C. Day/Time	D. Date/Time
Câu 13: Trong Access khi ta nhập dữ liệu cho trường “Ghi chú” trong CSDL (dữ liệu kiểu văn bản) mà nhiều hơn 255 kí tự thì ta cần phải định nghĩa trường đó theo kiểu nào?
A. Text			B. Currency		C. Longint		D. Memo
Câu 14: Trong của sổ CSDL đang làm việc, để tạo cấu trúc bảng trong chế độ thiết kế, thao tác thực hiện lệnh nào sau đây là đúng?
A. Nháy nút [image: ], rồi nháy đúp Design View		B. Nhấp đúp <tên bảng>
C. Nháy đúp vào Create Table in Design View		D. A hoặc C
Câu 15: Cửa sổ cấu trúc bảng được chia làm những phần nào?
A. Phần định nghĩa trường và phần các tính chất của trường
B. Tên trường (Field Name), kiểu dữ liệu (Data Type) và mô tả trường (Description)
C. Tên trường (Field Name), kiểu dữ liệu (Data Type) và các tính chất của trường (Field Properties)
D. Tên trường (Field Name), kiểu dữ liệu (Data Type), mô tả trường (Description) và các tính chất của trường (Field Properties)
Câu 16: Phát biểu nào sau đây là sai?
A. Phần định nghĩa trường gồm có: tên trường, kiểu dữ liệu và mô tả trường
B. Mô tả nội dung của trường bắt buộc phải có
C. Cấu trúc của bảng được thể hiện bởi các trường
D. Mỗi trường có tên trường, kiểu dữ liệu, mô tả trường và các tính chất của trường
Câu 17: Khi làm việc với cấu trúc bảng, để xác định tên trường, ta gõ tên trường tại cột:
A. File Name	B. Field Name	C. Name Field	D. Name
Câu 18: Khi làm việc với cấu trúc bảng, để xác định kiểu dữ liệu của trường, ta xác định tên kiểu dữ liệu tại cột:
A. Field Type	B. Description	C. Data Type	D. Field Properties
Câu 19: Trong khi tạo cấu trúc bảng, muốn thay đổi kích thước của trường, ta xác định giá trị mới tại dòng:
A. Field Name	B. Field Size	C. Description	D. Data Type
Câu 20: Khi tạo bảng, trường “DiaChi” có kiểu dữ liệu là Text, trong mục Field size ta nhập vào số 300. Sau đó ta lưu cấu trúc bảng lại.
A. Access báo lỗi	B. Trường DiaChi có tối đa 255 kí tự
C. Trường DiaChi có tối đa 300 kí tự	D. Trường DiaChi có tối đa 256 kí tự
Câu 21: Giả sử trường “DiaChi” có Field size là 50. Ban đầu địa chỉ của học sinh A là “Le Hong Phong”, giờ ta sửa lại thành “70 Le Hong Phong” thì kích thước CSDL có thay đổi như thế nào ?
A. Giảm xuống	B. Không đổi	C. Tăng lên
Câu 22: Các trường mà giá trị của chúng được xác định duy nhất mỗi hàng của bảng được gọi là:
A. Khóa chính 		B.Bản ghi chính	C.Kiểu dữ liệu		D.Trường chính
Câu 23: Hãy chọn phát biểu đúng trong các phát biểu sau?
A. Khi đã chỉ định khóa chính cho bảng, Access sẽ không cho phép nhập giá trị trùng hoặc để trống giá trị trong trường khóa chính
B. Trường khóa chính có thể nhận giá trị  trùng nhau
C. Trường khóa chính có thể để trống
D. Trường khóa chính phải là trường có kiểu dữ liệu là Number hoặc AutoNumber
Câu 24: Hãy chọn phát biểu sai  trong các phát biểu sau?
A. Khi đã chỉ định khóa chính cho bảng, Access sẽ không cho phép nhập giá trị trùng hoặc để trống giá trị trong trường khóa chính
B. Khóa chính có thể là một hoặc nhiều trường
C. Một bảng có thể có nhiều khóa chính
D. Có thể thay đổi khóa chính
Câu 25: Chọn phát biểu đúng khi nói về khóa chính và bảng (được thiết kế tốt) trong access?
A. Bảng không cần có khóa chính	B. Một bảng có thể có 2 trường cùng kiểu AutoNumber
C. Một bảng phải có một khóa chính	D. Một bảng có nhiều khóa chính
Câu 26: Để chỉ định khóa chính cho một bảng, sau khi chọn trường, ta thực hiện:
A. Edit  Primary key	B. Nháy nút [image: ]
C. A và B	D. A hoặc B
Câu 27: Trong Access, khi chỉ định khoá chính sai, muốn xóa bỏ khoá chính đã chỉ định, ta nháy chuột vào nút lệnh : 
A. [image: ]			B. [image: ]				C. [image: ]			D. [image: ]
Câu 28: Trong Access, muốn thay đổi khóa chính, ta chọn trường muốn chỉ định khóa chính rồi thực hiện:
A. Nháy nút [image: ]  hoặc chọn Edit  Primary Key	B. Nháy nút [image: ]  và chọn Edit  Primary Key
C. Nháy nút [image: ]  	D. Edit  Primary Key
Câu 29: Trong khi làm việc với cấu trúc bảng, muốn xác định khóa chính, ta thực hiện : ...........  Primary Key
A. Insert	B. Edit	C. File	D. Tools
Câu 30: Khi thiết kế xong bảng, nếu không chỉ định khóa chính thì:
A. Access đưa lựa chọn là tự động tạo trường khóa chính cho bảng có tên là ID với kiểu dữ liệu là AutoNumber
B. Access không cho phép lưu bảng
C. Access không cho phép nhập dữ liệu
D. Dữ liệu của bảng sẽ có hai hàng giống hệt nhau
Câu 31: Khi đang làm việc với cấu trúc bảng, muốn lưu cấu trúc vào đĩa, ta thực hiện :
A. View – Save	B. Tools – Save	C. Format – Save	D. File – Save
Câu 32: Để lưu cấu trúc bảng, ta thực hiện :
A. File  Save		B.Nháy nút [image: ]	
C. Nhấn tổ hợp phím Ctrl+S	D. A hoặc B hoặc C
Câu 33: Cho các thao tác sau: 
	1. Mở cửa sổ CSDL, chọn đối tượng Table trong bảng chọn đối tượng
	2. Trong cửa sổ Table: gõ tên trường, chọn kiểu dữ liệu, mô tả, định tính chất trường
	3. Tạo cấu trúc theo chế độ thiết kế
	4. Đặt tên và lưu cấu trúc bảng
	5. Chỉ định khóa chính
Để tạo cấu trúc một bảng trong CSDL, ta thực hiện lần lượt các thao tác:
A.1, 3, 2, 5, 4  		B.3, 4, 2, 1, 5		C.2, 3, 1, 5, 4 		D.1, 2, 3, 4, 5
Câu 34: Cấu trúc bảng bị thay đổi khi có một trong những thao tác nào sau đây?
A. Thêm/xóa trường					
B. Thay đổi tên, kiểu dữ liệu của trường, thứ tự các trường, khóa chính
C. Thay đổi các tính chất của trường	
D. Thêm/xóa trường, thay đổi tên, kiểu dữ liệu của trường, thứ tự các trường, khóa chính
Câu 35: Trong chế độ thiết kế, một trường thay đổi khi:
A.Một trong những tính chất của trường thay đổi	B. Kiểu dữ liệu của trường thay đổi
C.Tên trường thay đổi					D. Tất cả các phương án trên
Câu 36: Chế độ trang dữ liệu, không cho phép thực hiện thao tác nào trong các thao tác dưới đây?
A. Thêm bản ghi mới.	B. Xóa bản ghi.
C. Thêm bớt trường của bảng	D. Chỉnh sửa nội dung của bản ghi.
Câu 37: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn xóa trường đã chọn, thao tác thực hiện lệnh nào sau đây là đúng?
A. Không thực hiện được	B. Edit/Delete Field
C. Edit/Delete Rows	D. Insert/Rows
Câu 38: Trong cửa sổ CSDL, muốn thay đổi cấu trúc 1 bảng, ta chọn bảng đó rồi nháy:
A. [image: ]	B. [image: ]	C. [image: ]	D. [image: ]
Câu 39: Trong khi làm việc với cấu trúc bảng, muốn xóa một trường đã chọn, ta thực hiện :
A. Rows  Delete					B. RecordDelete Rows hoặc nháy nút [image: ]	
C. Edit Delete Rows hoặc nháy nút [image: ]		D. Edit Delete Rows hoặc nháy nút [image: ]
Câu 40: Trong khi làm việc với cấu trúc bảng, muốn chèn thêm một trường mới, ta thực hiện :
A. Insert –> Rows	B. Tools –> Insert Rows	C. Edit –> Insert Rows	D. File –> Insert Rows
Câu 41: Giả sử lúc tạo cấu trúc bảng thiếu một trường, để thêm một trường không phải ở vị trí cuối ta chọn vị trí cần thêm, sau đó nháy nút:
A. [image: ]	B. [image: ]	C. [image: ]	D. [image: ]
Câu 42: Một bảng có thể có tối đa bao nhiêu trường
A.255			B.552			C.525			D.Chỉ bị giới hạn bởi bộ nhớ
Câu 43: Muốn xóa một bảng, ta chọn tên bảng cần xóa trong trang bảng rồi thực hiện:
A. Nhấn phím Delete	B. Nháy nút [image: ]	C. Edit  Delete	D. A hoặc B hoặc C
Câu 44: Muốn đổi bảng THISINH thành tên bảng HOCSINH ta thực hiện :
A. Nháy chọn tên THISINH / gõ tên HOCSINH.
B. Nháy phải chuột  vào tên THISINH/ Rename / gõ tên HOCSINH.
C. Trong chế độ thiết kế của bảng THISINH, gõ tên HOCSINH vào thuộc tính caption của trường chính.
D. File / Rename / gõ tên HOCSINH
Câu 45: Trong Access, muốn nhập dữ liệu vào cho một bảng, ta thực hiện :
A. Nhập trực tiếp trong chế độ trang dữ liệu	B. Nháy đúp trái chuột lên tên bảng cần nhập dữ liệu
C. Dùng biểu mẫu 	D. A hoặc B hoặc C
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BÀI 5: CÁC THAO TÁC CƠ BẢN TRÊN BẢNG

Câu 1: Cập nhật dữ liệu là:
A. Thay đổi dữ liệu trong các bảng
B. Thay đổi dữ liệu trong các bảng gồm: thêm bản ghi mới, chỉnh sửa, xóa bản ghi  
C. Thay đổi cấu trúc của bảng
D. Thay đổi cách hiển thị dữ liệu trong bảng
Câu 2: Chế độ nào cho phép thực hiện cập nhật dữ liệu trên bảng một cách đơn giản?
A. Chế độ hiển thị trang dữ liệu			B. Chế độ biểu mẫu
C. Chế độ thiết kế					D. Một đáp án khác
Câu 3: Trong khi nhập dữ liệu cho bảng, muốn chèn thêm một bản ghi mới, ta thực hiện : Insert  ...........
A. Record	B. New Rows	C. Rows	D. New Record
Câu 4: Muốn chèn thêm một bản ghi mới, ta thực hiện:
A. Insert  New Record				B. Nháy nút [image: ]	
C. Nháy chuột trực tiếp vào bản ghi trống ở cuối bảng rồi gõ dữ liệu tương ứng
D. Cả 3 đáp án trên đều đúng
Câu 5: Phát biểu nào sai trong các phát biểu sau?
A. Có thể thêm bản ghi vào giữa các bản ghi đã có trong bảng
B. Có thể sử dụng phím Tab để di chuyển giữa các ô trong bảng ở chế độ trang dữ liệu
C. Tên trường có thể chứa các kí tự số và không thể dài hơn 64 kí tự
D. Bản ghi đã bị xóa thì không thể khôi phục lại được
Câu 6: Để xóa một bản ghi ta thực hiện thao tác nào sau đây?
A. Chọn Insert → Delete Record rồi chọn Yes.	B. Nháy [image: ] trên thanh công cụ rồi chọn Yes.
C. Nháy [image: ]  trên thanh công cụ rồi chọn Yes.	D. Cả A và B đều đúng.
Câu 7: Trong khi nhập dữ liệu cho bảng, muốn xóa một bản ghi đã được chọn, ta bấm phím:
A. Enter	B. Space	C. Tab	D. Delete
Câu 8: Trong khi nhập dữ liệu cho bảng, muốn xóa một bản ghi đã được chọn, ta thực hiện:
A. Edit/Delete	B. Edit/Delete Record	C. Nhấn phím Delete	D. Cả 3 đáp án trên đều đúng
Câu 9: Để sắp xếp dữ liệu trường nào đó tăng dần ta chọn biểu tượng nào sau đây?
A. Biểu tượng [image: ]	B. Biểu tượng[image: ]	C. Biểu tượng [image: ]	D. Biểu tượng [image: ]
Câu 10: Để sắp xếp dữ liệu trường nào đó giảm dần ta chọn biểu tượng nào sau đây?
A. Biểu tượng [image: ].	B. Biểu tượng [image: ]	C. Biểu tượng [image: ]	D. Biểu tượng [image: ]
Câu 11: Bảng đã được hiển thị ở chế độ trang dữ liệu, với một trường đã chọn, muốn sắp xếp các bản ghi theo thứ tự tăng,  thao tác thực hiện lệnh nào sau đây là đúng?
A. Record/Sort/Sort Descending	B. Insert/New Record
C. Edit/ Sort Ascending	D. Record/Sort/Sort Ascending
Câu 12: Khẳng định nào sau đây là sai?
A. Lọc là một công cụ của hệ QT CSDL cho phép tìm ra những bản ghi thỏa mãn một số điều kiện nào đó phục vụ tìm kiếm
B. Lọc tìm được các bản ghi trong nhiều bảng thỏa mãn với điều kiện lọc
C. Sử dụng lọc theo ô dữ liệu đang chọn để tìm nhanh các bản ghi có dữ liệu trùng với ô đang chọn
D. Sử dụng lọc theo mẫu để tìm các bản ghi thỏa mãn các tiêu chí phức tạp
Câu  13: Trong Access, từ Filter có ý nghĩa gì ?
A. Tìm kiếm dữ liệu		B. Lọc dữ liệu		C. Sắp xếp dữ liệu		D. Xóa dữ liệu
Câu 14: Để lọc dữ liệu theo ô đang chọn, ta chọn biểu tượng nào sau đây?
A. Biểu tượng [image: ]	B. Biểu tượng [image: ]	C. Biểu tượng [image: ]	D. Biểu tượng [image: ]
Câu 15: Cho các thao tác sau:
(1) Nháy nút [image: ]
(2) Nháy nút [image: ]
(3) Chọn ô có dữ liệu cần lọc
Trình tự các thao tác để thực hiện được việc lọc theo ô dữ liệu đang chọn là:
A. (3)  (1)  (2)	B. (3)  (2)  (1)	C. (3)  (1)	D. (3)  (2)
Câu  16: Trong Access, muốn thực hiện việc hủy lọc dữ liệu, ta nháy nút :
A. [image: ]			B. [image: ]			C. [image: ]			D. [image: ]
Câu 17: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn lọc theo mẫu, thao tác thực hiện lệnh nào sau đây là đúng?
A. Record/Fillter/Fillter By Form	B. Insert/Colum
C. Record/Sort/Sort Ascending	D. Record/Fillter/Fillter By Selection
Câu 18: Để lọc theo mẫu, ta chọn biểu tượng nào sau đây?
A. Biểu tượng [image: ]	B. Biểu tượng [image: ]	C. Biểu tượng [image: ]	D. Biểu tượng [image: ]
Câu 19: Cho các thao tác sau:
(1) Nháy nút [image: ]
(2) Nháy nút [image: ]
(3) Nhập điều kiện lọc vào từng trường tương ứng theo mẫu
Trình tự các thao tác để thực hiện được việc lọc theo mẫu là:
A. (2)  (3)  (1)	B. (3)  (2)  (1)	C. (1)  (2)  (3)	D. (1)  (3)  (2)

Câu 20: Để lọc ra danh sách học sinh “Nam” trong lớp, ta thực hiện:
A. Trên trường (Giới Tính) ta nháy nút [image: ]
B. Nháy nút [image: ], rồi gõ vào chữ (“Nam”) trên trường (Giới Tính), sau đó nháy nút [image: ]
C. Trên trường (Giới Tính) ta click chuột vào một ô có giá trị là (Nam), rồi nháy nút [image: ]
D. Cả B và C đều đúng
Câu 21: Để lọc danh sách học sinh của hai tổ 1 và 2 của lớp 12A1, ta chọn lọc theo mẫu, trong trường “Tổ” ta gõ vào:
A. 1 or  2	B. Không làm được	C. 1 and 2	D. 1 , 2
Câu 22: Trên Table ở chế độ Datasheet View, Nhấn Ctrl+F:
A. Mở hộp thoại Font				B. Mở hộp thoại Filter	
C. Mở hộp thoại Sort				D. Mở hộp thoại Find and Replace
Câu 23: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn tìm cụm từ nào đó trong bảng, ta thực hiện thao tác:
A. Edit/ Find					B. Record/ Filter/ Filter By Selection
C. Record/ Sort/ Sort Decending		D. Record/ Filter/ Filter By Form
Câu 24: Để tìm kiếm và thay thế dữ liệu trong bảng ta chọn biểu tượng nào sau đây?
A. Biểu tượng [image: ]	B. Biểu tượng [image: ]	C. Biểu tượng [image: ]	D. Biểu tượng [image: ]
Câu 25: Trong Access, muốn in dữ liệu ra giấy, ta thực hiện
A. Edit – Print	B. File – Print	C. Windows – Print	D. Tools – Print
Câu 26: Trong Access, muốn xem lại trang dữ liệu trước khi in, ta thực hiện :
A. File – Print Preview   		B. View – Print Preview   
C. Windows – Print Preview		D. Tools – Print Preview
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BÀI 6: BIỂU MẪU

Câu 1: Để tạo biểu mẫu ta chọn đối tượng nào trên bảng chọn đối tượng? 
A. Queries		B. Forms		C. Tables		D. Reports
Câu 2: Trong Access, ta có thể sử dụng biểu mẫu để :
A. Tính toán cho các trường tính toán	B. Sửa cấu trúc bảng
C. Xem, nhập và sửa dữ liệu			D. Lập báo cáo
Câu 3: Để tạo biểu mẫu, trước đó phải có dữ liệu nguồn là từ:
A. Bảng hoặc mẫu hỏi				B. Bảng hoặc báo cáo
C. Mẫu hỏi hoặc báo cáo			D. Mẫu hỏi hoặc biểu mẫu
Câu 4: Trong Access, muốn tạo biểu mẫu theo cách dùng thuật sĩ, ta chọn:
A. Create form for using Wizard		B. Create form by using Wizard
C. Create form with using Wizard		D. Create form in using Wizard
Câu 5: Trong Access, muốn tạo biểu mẫu theo cách tự thiết kế, ta chọn:
A. Create form in Design View		B. Create form by using Wizard
C. Create form with using Wizard		D. Create form by Design View
Câu 6: Cho các thao tác:
	(1) Gõ tên cho biểu mẫu rồi nháy Finish
	(2) Chọn đối tượng Form trong bảng chọn đối tượng rồi nháy đúp vào Create form by using wizard
	(3) Chọn kiểu cho biểu mẫu rồi nhấn Next
	(4) Chọn cách bố trí biểu mẫu rồi nhấn Next
	(5) Trong hộp thoại Form Wizard, chọn bảng (hoặc mẫu hỏi) từ ô Tables/Queries, tiếp theo là chọn các trường đưa vào biểu mẫu rồi nhấn Next
Trình tự các thao tác để có thể thực hiện tạo biểu mẫu bằng cách dùng thuật sĩ sẽ là:
A (2)  (5)  (3)  (4)  (1)			B. A (2)  (5)  (4)  (3)  (1)
C. (5)  (2)  (3)  (4)  (1)			D. A (2)  (3)  (4)  (5)  (1)
Câu 7: Các thao tác thay đổi hình thức biểu mẫu, gồm:
A. Thay đổi nội dung các tiêu đề				B. Sử dụng phông chữ tiếng Việt
C. Di chuyển các trường, thay đổi kích thước trường	D. Cả A, B và C đều đúng
Câu 8: Chỉnh sửa biểu mẫu (thay đổi hình thức biểu mẫu) chỉ thực hiện được ở chế độ:
A. Thiết kế		B. Trang dữ liệu		C. Biểu mẫu		D. Thuật sĩ
Câu 9: Phát biểu nào trong các phát biểu sau là sai?
A. Chế độ biểu mẫu có giao diện thân thiện, thường được sử dụng để cập nhật dữ liệu
B. Bảng ở chế độ hiển thị trang dữ liệu có thể được sử dụng để cập nhật dữ liệu
C. Để làm việc trên cấu trúc của biểu mẫu thì biểu mẫu phải ở chế độ thiết kế
D. Có thể tạo biểu mẫu bằng cách nhập dữ liệu trực tiếp (nháy đúp vào Create form by entering data)
Câu 10: Trong chế độ thiết kế của biểu mẫu, ta có thể:
A. Sửa đổi cấu trúc của biểu mẫu			B. Sửa đổi dữ liệu
C. Nhập và sửa dữ liệu				D. Xem, sửa, xóa và nhập dữ liệu 
Câu 11: Trong chế độ thiết kế của biểu mẫu, ta có thể:
A. Sửa đổi thiết kế cũ 
B. Thiết kế mới cho biểu mẫu	, sửa đổi thiết kế cũ
C. Thiết kế mới cho biểu mẫu, xem hay sửa đổi thiết kế cũ					
D. Thiết kế mới cho biểu mẫu, xem hay sửa đổi thiết kế cũ, xem, sửa, xóa và nhập dữ liệu 
Câu 12: Các thao tác có thể thực hiện trong chế độ thiết kế, gồm:
A. Thêm/bớt, thay đổi vị trí, kích thước các trường dữ liệu				
B. Định dạng phông chữ cho các trường dữ liệu và các tiêu đề
C. Tạo những nút lệnh để đóng biểu mẫu, chuyển đến bản ghi đầu, bản ghi cuối…
D. Cả A, B và C đều đúng
Câu 13: Để làm việc trong chế độ thiết kế của biểu mẫu, ta thực hiện:
A. Chọn biểu mẫu rồi nháy nút [image: ]
B. Chọn biểu mẫu rồi nháy nút [image: ] hoặc nháy nút [image: ] nếu đang ở chế độ biểu mẫu
C. Chọn biểu mẫu rồi nháy nút [image: ] và nháy nút [image: ] nếu đang ở chế độ thiết kế
D. Chọn biểu mẫu rồi nháy nút [image: ] hoặc nháy nút [image: ] nếu đang ở chế độ thiết kế
Câu 14: Thao tác nào sau đây có thể thực hiện được trong chế độ biểu mẫu?
A. Thêm một bản ghi mới			B. Định dạng font chữ cho các trường dữ liệu
C. Tạo thêm các nút lệnh			D. Thay đổi vị trí các trường dữ liệu 
Câu 15: Để làm việc trong chế độ biểu mẫu, ta không thực hiện thao tác nào sau đây?
A. Nháy đúp chuột lên tên biểu mẫu		B. Chọn biểu mẫu rồi nháy nút  [image: ]
C.  Nháy nút  [image: ], nếu đang ở chế độ thiết kế	D. Nháy nút  [image: ], nếu đang ở chế độ thiết kế
Câu 16: Để làm việc trong chế độ biểu mẫu, ta thực hiện:
A. Nháy đúp lên tên biểu mẫu			B. Chọn biểu mẫu rồi nháy nút [image: ]
C. Nháy nút [image: ] nếu đang ở chế độ thiết kế		D. Cả A, B và C đều đúng
Câu 17: Phát biểu nào sau đây là sai?
A. Việc cập nhật dữ liệu trong biểu mẫu thực chất là cập nhật dữ liệu trên bảng dữ liệu nguồn
B. Việc nhập dữ liệu bằng cách sử dụng biểu mẫu sẽ thuận tiện hơn, nhanh hơn, ít sai sót hơn
C. Có thể sử dụng bảng ở chế độ trang dữ liệu để cập nhật dữ liệu trực tiếp
D. Khi tạo biểu mẫu để nhập dữ liệu thì bắt buộc phải xác định hành động cho biểu mẫu
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BÀI 7: LIÊN KẾT GIỮA CÁC BẢNG

Câu 1: Liên kết giữa các bảng cho phép:
A. Tránh được dư thừa dữ liệu 		C. Có thể có được thông tin tổng hợp từ nhiều bảng
C. Nhất quán dữ liệu				D. Cả A, B, C đều đúng
Câu 2: Để tạo liên kết giữa các bảng, ta chọn: 
A.Tool/ Relationships hoặc nháy nút [image: ] 		B.Tool/ Relationships
C.Edit/ Insert/ Relationships				D.Tất cả đều đúng
Câu 3: Sắp xếp các bước theo đúng thứ tự thực hiện để tạo liên kết giữa hai bảng:
1. Kéo thả trường khóa làm liên kết từ bảng phụ tới bảng chính( trường khóa làm khóa chính)
2. Chọn các tham số liên kết
3. Hiển thị hai bảng (các trường) muốn tạo liên kết
4. Mở cửa sổ Relationships
A. 2413		B. 4312		C. 4231		D. 3142
Câu 4: Các bước để tạo liên kết giữa các bảng là:
		1. Chọn Tool\Relationships…
		2. Tạo liên kết đôi một giữa các bảng
		3. Đóng hộp thoại Realationships/ Yes để lưu lại
		4. Chọn các bảng sẽ liên kết
A.1, 4, 2, 3 		B.2, 3, 4, 1		C.1, 2, 3, 4 		D.4, 2, 3, 1 
Câu 5: Khi muốn thiết lập liên kết giữa hai bảng thì mỗi bảng phải có:
A. Khóa chính giống nhau			B. Số trường bằng nhau
C. Số bản ghi bằng nhau			D. Tất cả đều sai
Câu 6: Trong Access, để tạo liên kết giữa 2 bảng thì hai bảng đó phải có hai trường thỏa mãn điều kiện:
A. Có tên giống nhau				B. Có kiểu dữ liệu giống nhau
C. Có ít nhất một trường là khóa chính	D. Cả A, B, C
Câu 7: Trong Access, khi tạo liên kết giữa các bảng, thì :
A. Phải có ít nhất một trường là khóa chính                    B. Cả hai trường phải là khóa chính
C. Hai trường không nhất thiết phải là khóa chính          D. Một trường là khóa chính, một trường không
Câu 8: Điều kiện cần để tạo được liên kết là:
A. Phải có ít nhất hai bảng		B. Phải có ít nhất một bảng và một mẫu hỏi
C. Phải có ít nhất một bảng mà một biểu mẫu	D. Tổng số bảng và mẫu hỏi ít nhất là 2
Câu 9: Điều kiện để tạo mối liên kết giữa hai bảng là :
A. Trường liên kết của hai bảng phải cùng kiểu dữ liệu   B. Trường liên kết của hai bảng phải là chữ hoa
C. Trường liên kết của hai bảng phải là kiểu dữ liệu số    D. Trường liên kết của hai bảng phải khác nhau về kiểu dữ liệu
Câu 10: Tại sao khi lập mối quan hệ giữa hai trường của hai bảng nhưng Access lại không chấp nhận
A. Vì bảng chưa nhập dữ liệu
B. Vì một hai bảng này đang sử dụng (mở cửa sổ table)
C. Vì hai trường tham gia vào dây quan hệ khác kiểu dữ liệu(data type), khác chiều dài (field size)
D. Các câu B và C đều đúng
Câu 11: Khi liên kết bị sai, ta có thể sửa lại bằng cách chọn đường liên kết cần sửa, sau đó:
A. Nháy đúp vào đường liên kết  chọn lại trường cần liên kết	
B. Edit  RelationShip
C. Tools  RelationShip  Change Field	
D. Chọn đường liên kết giữa hai bảng đó và nhấn phím Delete
Câu 12: Muốn xóa liên kết giữa hai bảng, trong cửa sổ Relationships ta thực hiện:
A. Chọn hai bảng và nhấn phím Delete
B. Chọn đường liên kết giữa hai bảng đó và nhấn phím Delete
C. Chọn tất cả các bảng và nhấn phím Delete
D. Cả A, B, C đều sai
Câu 13: Để xóa liên kết, trước tiên ta chọn liên kết cần xóa. Thao tác tiếp theo nào sau đây là sai?
A. Bấm Phím Delete  Yes		B. Click phải chuột, chọn Delete  Yes
C. Edit  Delele  Yes		D. Tools  RelationShip  Delete  Yes
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----------------------------------------------------------------------------------------------------------------------------

BÀI 8: TRUY VẤN DỮ LIỆU

Câu 1: Truy vấn dữ liệu có nghĩa là:
A. In dữ liệu					C. Tìm kiếm và hiển thị dữ liệu
B. Cập nhật dữ liệu				D. Xóa các dữ liệu không cần đến nữa
Câu 2: Nếu những bài toán mà câu hỏi chỉ liên quan tới một bảng, ta có thể:
A. Thực hiện thao tác tìm kiếm và lọc trên bảng hoặc biểu mẫu	B. Sử dụng mẫu hỏi
C. A và B đều đúng							D. A và B đều sai
Câu 3: Nếu những bài toán phức tạp, liên quan tới nhiều bảng, ta sủ dụng:
A. Mẫu hỏi			B. Bảng		C. Báo cáo			D. Biểu mẫu
Câu 4: Để hiển thị một số bản ghi nào đó trong cơ sở dữ liệu, thống kê dữ liệu, ta dùng:
A. Mẫu hỏi			B. Câu hỏi		C. Liệt kê			D. Trả lời
Câu 5: Trước khi tạo mẫu hỏi để giải quyết các bài toán liên quan tới nhiều bảng, thì ta phải thực hiện thao tác nào?
A. Thực hiện gộp nhóm				B. Liên kết giữa các bảng
C. Chọn các trường muốn hiện thị ở hàng Show	D. Nhập các điều kiện vào lưới QBE
Câu 6: Mẫu hỏi thường được sử dụng để:
A. Sắp xếp các bản ghi, chọn các trường để hiển thị, thực hiện tính toán
B. Chọn các bản ghi thỏa mãn điều kiện cho trước
C. Tổng hợp và hiển thị thông tin từ nhiều bảng hoặc mẫu hỏi khác
D. Cả A, B và C
Câu 7: Các chế độ làm việc với mẫu hỏi là:
A. Mẫu hỏi						B. Mẫu hỏi và thiết kế			
C. Trang dữ liệu và thiết kế				D. Trang dữ liệu và mẫu hỏi
Câu 8: Kết quả thực hiện mẫu hỏi cũng đóng vai trò như:
A. Một bảng		B. Một biểu mẫu	C. Một báo cáo		D. Một mẫu hỏi
Câu 9: Kết quả thực hiện mẫu hỏi có thể tham gia vào việc tạo ra:
A. Bảng, biểu mẫu, mẫu hỏi hay báo cáo
B. Bảng, biểu mẫu khác, mẫu hỏi khác hay các trang khác
C. Bảng, biểu mẫu, mẫu hỏi khác hay báo cáo
D. Bảng, biểu mẫu, mẫu hỏi khác
Câu 10: “ /” là phép toán thuộc nhóm:
A. Phép toán so sánh		B. Phép toán số học	C. Phép toán logic	D. Không thuộc các nhóm trên
Câu 11: “ >=” là phép toán thuộc nhóm:
A. Phép toán so sánh		B. Phép toán số học	C. Phép toán logic	D. Không thuộc các nhóm trên
Câu 12: “ not” là phép toán thuộc nhóm:
A. Phép toán so sánh		B. Phép toán số học	C. Phép toán logic	D. Không thuộc các nhóm trên
Câu 13: Phát biểu nào sai trong các phát biểu sau khi nói về mẫu hỏi?
A. Biểu thức số học được sử dụng để mô tả các trường tính toán 
B. Biểu thức logic được sủ dụng khi thiết lập bộ lọc cho bảng, thiết lập điều kiện lọc để tạo mẫu hỏi
C. Hằng văn bản được viết trong cặp dấu nháy đơn
D. Hàm gộp nhóm là các hàm như: SUM, AVG, MIN, MAX, COUNT 
Câu 14: Để xem hay sửa đổi thiết kế của mẫu hỏi, trước tiên ta chọn mẫu hỏi rồi nháy nút:
A. [image: ]			B. [image: ]		C. [image: ]		D. [image: ] hoặc [image: ]
Câu 15: Cửa sổ mẫu hỏi ở chế độ thiết kế gồm hai phần là:
A. Phần trên (dữ liệu nguồn) và phần dưới (lưới QBE)
B. Phần định nghĩa trường và phần khai báo các tính chất của trường
C. Phần chứa dữ liệu và phần mô tả điều kiện mẫu hỏi
D. Phần tên và phần tính chất
Câu 16: Khi xây dựng các truy vấn trong Access, để sắp xếp các trường trong mẫu hỏi, ta nhập điều kiện vào dòng nào trong lưới QBE?
A. Criteria			B. Show		C. Sort     		D.Field
Câu 17: Trong lưới QBE của cửa sổ mẫu hỏi (mẫu hỏi ở chế độ thiết kế) thì hàng Criteria có ý nghĩa gì?
A. Mô tả điều kiện để chọn các bản ghi đưa vào mẫu hỏi	
B. Xác định các trường xuất hiện trong mẫu hỏi
C. Xác định các trường cần sắp xếp
D. Khai báo tên các trường được chọn
Câu 18: Bảng DIEM có các trường MOT_TIET, HOC_KY. Để tìm những học sinh có điểm một tiết trên 7 và điểm thi học kỳ trên 5 , trong dòng Criteria của trường HOC_KY, biểu thức điều kiện nào sau đây là đúng:
A. MOT_TIET > 7 AND HOC_KY >5 		B. [MOT_TIET] > 7 AND [HOC_KY]>5
C. [MOT_TIET] > 7 OR [HOC_KY]>5		D. [MOT_TIET] > "7" AND [HOC_KY]>"5"
Câu 19: Bảng DIEM có các trường MOT_TIET, HOC_KY. Trong Mẫu hỏi, biểu thức số học để tạo trường mới TRUNG_BINH, lệnh nào sau đây là đúng:
A. TRUNG_BINH:(2* [MOT_TIET] + 3*[HOC_KY])/5	       
B. TRUNG_BINH:(2* MOT_TIET + 3*HOC_KY)/5
C. TRUNG_BINH:(2* [MOT_TIET] + 3*[HOC_KY]):5          
D. TRUNG_BINH=(2* [MOT_TIET] + 3*[HOC_KY])/5
Câu 20: Khi hai (hoặc nhiều hơn) các điều kiện được kết nối bằng AND hoặc OR, kết quả được gọi là:
A. Tiêu chuẩn đơn giản				B. Tiêu chuẩn phức hợp
C. Tiêu chuẩn mẫu					D. Tiêu chuẩn kí tự
Câu 21: Để thêm hàng Total vào lưới thiết kế QBE, ta nháy vào nút lệnh:
A. [image: ]			B. [image: ]			C. [image: ]		D. [image: ]
Câu 22: Để thực hiện mẫu hỏi ( đưa ra kết quả của truy vấn) ta có thể sử dụng cách nào sau đây? 
A. Nháy nút  [image: ]       				C.  Nháy nút [image: ]
B. Chọn lệnh View Datasheet View	D.  Cả 3 cách trên đều đúng
Câu 23: Nếu thêm nhầm một bảng làm dữ liệu nguồn trong khi tạo mẫu hỏi, để bỏ bảng đó khỏi cửa sổ thiết kế, ta thực hiện:
A. Edit Delete						B. Query Remove Table
C. Chọn bảng cần xóa rồi nhấn phím Backspace		D. Tất cả đều đúng
Câu 24: Để thêm bảng làm dữ liệu nguồn cho mẫu hỏi, ta nháy nút lệnh:
A. [image: ]			B. [image: ]			C. [image: ]		D. [image: ]
Câu 25: Trong cửa sổ CSDL đang làm việc, để mở một mẫu hỏi đã có, ta thực hiện :
A.Queries/ Nháy đúp vào tên mẫu hỏi. 		B.Queries/ nháy nút Design.
C.Queries/ Create Query by using Wizard		D.Queries/ Create Query in Design Wiew.
Câu 26: Trong cửa sổ CSDL đang làm việc, để tạo một Mẫu hỏi mới bằng cách dùng thuật sĩ, thao tác thực hiện lệnh nào sau đây là đúng?
A. Chọn Tables /Create Table in Design View 	B. Chọn Queries/Create Query by using wizard
C. Chọn Queries/Create Query in Design View	D. Chọn Forms /Create Form by using wizard
Câu 27: Trình tự thao tác để tạo mẫu hỏi bằng cách tự thiết kế, biết:
          	(1) Chọn bảng hoặc mẫu hỏi khác làm dữ liệu nguồn
	(2) Nháy nút [image: ]
(3) Nháy đúp vào Create query in Design view
(4) Chọn các trường cần thiết trong dữ liệu nguồn để đưa vào mẫu hỏi
(5) Mô tả điều kiện mẫu hỏi ở lưới QBE
A. (1) -> (3) -> (4) -> (5) ->(2)			B. (3) -> (1) -> (4) -> (5) ->(2)
C. (3) -> (1) -> (5) -> (4) ->(2)			D. (3) -> (4) -> (5) -> (1) ->(2)
Câu 28: Phát biểu nào sau đây là sai khi nói về mẫu hỏi?
A. Trên hàng Field có tất cả các trường trong các bảng liên quan đến mẫu hỏi
B. Ngầm định các trường đưa vào mẫu hỏi đều được hiển thị
C. Có thể thay đổi thứ tự các trường trong mẫu hỏi
D. Avg, Min, Max, Count là các hàm tổng hợp dữ liệu
Câu 29: Phát biểu nào sau đây là đúng khi nói về mẫu hỏi?
A. Lưới QBE là nơi người dùng chọn các trường để đưa vào mẫu hỏi, thứ tự sắp xếp và xác định điều kiện
B. Thứ tự sắp xếp cần được chỉ ra ở hàng Total
C. Mỗi trường trên hàng Field chỉ xuất hiện đúng một lần
D. Mỗi mẫu hỏi phải dùng hai bảng dữ liệu nguồn trở lên

ĐÁP ÁN:
	1C
	2A
	3A
	4A
	5B
	6D
	7C
	8A
	9C
	10B

	11A
	12C
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	14D
	15A
	16C
	17A
	18B
	19A
	20B

	21D
	22D
	23A
	24C
	25A
	26B
	27B
	28D
	29A
	





BÀI 9: BÁO CÁO VÀ KẾT XUẤT BÁO CÁO

Câu 1: Khi cần in dữ liệu theo một mẫu cho trước, cần sử dụng đối tượng:
A. Báo cáo		B. Bảng			C. Mẫu hỏi			D. Biểu mẫu
Câu 2: Báo cáo thường được sử dụng để:
A. Thể hiện được sự so sánh  và tổng hợp thông tin từ các nhóm dữ liệu
B. Trình bày nội dung văn bản theo mẫu quy định
C. A và B đều đúng
D. A và B đều sai
Câu 3: Để tạo một báo cáo, cần trả lời các câu hỏi gì?
A. Báo cáo được tạo ra để kết xuất thông tin gì? Dữ liệu từ những bảng, mẫu hỏi nào sẽ được đưa vào báo cáo? Dữ liệu sẽ được nhóm như thế nào?
B. Báo cáo được tạo ra để kết xuất thông tin gì? Dữ liệu từ những bảng, mẫu hỏi nào sẽ được đưa vào báo cáo? Dữ liệu sẽ được nhóm như thế nào? Tạo báo cáo bằng cách nào?
C. Báo cáo được tạo ra để kết xuất thông tin gì? Dữ liệu từ những bảng, mẫu hỏi nào sẽ được đưa vào báo cáo? Dữ liệu sẽ được nhóm như thế nào? Hình thức báo cáo như thế nào?
D. Báo cáo được tạo ra để kết xuất thông tin gì? Dữ liệu từ những bảng, mẫu hỏi nào sẽ được đưa vào báo cáo? 
Câu 4: Để làm việc với báo cáo, chọn đối tượng nào trong bảng chọn đối tượng?
A. Tables		B. Forms			C. Queries			D. Reports
Câu 5: Để tạo nhanh một báo cáo, thường chọn cách nào trong các cách dưới đây:
A. Người dùng tự thiết kế
B. Dùng thuật sĩ tạo báo cáo
C. Dùng thuật sĩ tạo báo cáo và sau đó sửa đổi thiết kế báo cáo được tạo ra ở bước trên
D. Tất cả các trên  đều sai
Câu 6: Đối tượng nào sau đây không thể cập nhật dữ liệu?
A. Bảng, biểu mẫu		B. Mẫu hỏi, báo cáo		C. Báo cáo		D. Bảng
Câu 7: Giả sử bảng HOCSINH gồm có các trường MAHS, HOTEN, DIEM. LOP. Muốn hiển thị thông tin điểm cao nhất của mỗi lớp để sử dụng lâu dài, trong Access ta sử dụng đối tượng nào trong các đối tượng sau?
A. Reports	 	B. Queries 		C. Forms    			D. Tables
Câu 8: Khi muốn sửa đổi thiết kế báo cáo, ta chọn báo cáo rồi nháy nút:
A. [image: ]		B. [image: ]		C. [image: ]			D. [image: ]
Câu 9: Khi báo cáo đang ở chế độ thiết kế, có thể nháy nút nào để xem kết quả của báo cáo?
A. [image: ]		B. [image: ]		C. [image: ]			D. [image: ]
Câu 10: Khi mở một báo cáo, nó được hiển thị dưới dạng nào?
A. Chế độ thiết kế	B. Chế độ trang dữ liệu	C. Chế độ biểu mẫu	D. Chế độ xem trước
Câu 11: Chọn phát biểu sai trong các phát biểu sau?
A. Có thể định dạng kiểu chữ, cỡ chữ cho các tiêu đề và dữ liệu trong báo cáo
B. Lưu báo cáo để sử dụng nhiều lần
C. Báo cáo tạo bằng thuật sĩ đạt yêu cầu về hình thức
D. Có thể chèn hình ảnh cho báo cáo thêm sinh động
Câu 12: Với báo cáo, ta không thể làm được việc gì trong những việc sau đây?
A. Chọn trường đưa vào báo cáo		B. Lọc những bản ghi thỏa mãn một điều kiện nào đó 
C. Gộp nhóm dữ liệu				D. Bố trí báo cáo và chọn kiểu trình bày

ĐÁP ÁN:
	1A
	2C
	3A
	4D
	5C
	6B
	7C
	8D
	9B
	10D

	11C
	12B
	
	
	
	
	
	
	
	



II. BÀI TẬP THỰC HÀNH

BÀI 1: Cho CSDL  quản lý bán hàng, có các bảng thông tin như sau:
KHACHHANG(makh, hotenkh, diachi, email)
	Diễn giải: mỗi khách hàng có makh: mã khách hàng, hotenkh: họ và chữ lót khách hàng, diachi: địa chỉ của khách hàng, email: hộp thư của khách hàng.
HOADON(mahd, ngayban, makh)
	Diễn giải: mahd: mã hóa đơn, ngayban: ngày bán, makh: mã khách hàng.
HANGBAN(mahang, mahd, soluong).
	Diễn giải: mahang: mã hàng, mahd: mã hóa đơn, soluong: số lượng hàng bán
HANG(mahang, tenhang, donvi, dongia)
	Diễn giải: mahang: mã hàng hóa, tenhang: tên hàng hóa, donvi: đơn vị tính, dongia: đơn giá hàng.
Câu 1: Xác định khóa chính của các bảng:
	BẢNG
	KHACHANG
	HOADON
	HANGBAN
	HANG

	KHÓA CHÍNH
	
	
	
	



 Câu 2: Thiết lập liên kết giữa các bảng
 Câu 3:Tạo các truy vấn sau:
    a/ Liệt kê danh sách khách hàng có địa chỉ “TP Cao Lãnh”
[image: ]

  b/ Liệt kê danh sách hóa đơn những tên hàng đã bán trong tháng 04/2009 cho khách hàng có địa chỉ “Thanh Bình”;

[image: ]

BÀI 2:
Câu 1: Tạo tập tin CSDL có tên ONTAP.MDB nằm trong thư mục My Document
a. Thiết kế  các Tables sau: DIEM và SOBAODANH. 
b. Tạo mối quan hệ giữa hai Table này 
c. Nhập dữ liệu theo nội dung bên dưới (T1) và (T2).

[image: ]	[image: ] 

[image: ] (T1)

[image: ](T2)

Câu 2: Lập danh sách chứa các trường So_bao_danh, Ho_ten, Ngay_sinh, Toan, Van, Tinhoc,  Phongthi và tạo thêm trường mới DiemTB theo công thức 
DiemTB=(2*Toan+2*Van+Tinhoc)/5. Sắp xếp trường SO_BAO_DANH theo chiều tăng dần, đặt tên Query này là: Q_DIEMTB

[image: ]

Câu 3: Lập danh sách đếm số lượng các loại điểm thi môn Toán lớn hơn 7

[image: ]

H dẫn: Chọn vào lưới QBE  trường điểm TOAN hai lần
 (
Đổi tên Field thành 
Ðiểm Tóan
) (
Đổi tên Field thành 
Số lýợng
)[image: ]

Câu 4: Tạo Form chứa 3 trường SO_BAO_DANH, HO_TEN, NGAY_SINH trong Form này có chứa một Form khác chứa các thông tin như sau: SO_BAO_DANH, TOAN, VAN, TINHOC ,DIEMTB

Câu 5: Hãy sử dụng kiến thức đã học hãy lập bảng báo cáo trong đó chứa các thông tin về Phòng thi, số báo danh, Tóan, Văn, Tin học, Điểm TB. Thỏa mãn các yêu cầu sau:
· Phân nhóm trên trường Phòng thi
· Trong nhóm sắp xếp tăng dần trên trường Số báo danh
· Trên cột Điểm TB tính trị trung bình, thấp nhất, cao nhất.

[image: ]

Câu 6: Thực hiện các thao tác để chỉnh sửa lại báo cáo để tạo thành báo cáo hoàn chỉnh: gõ chữ tiếng việt, chỉnh phông chữ, màu sắc chữ…

BÀI 3: 

Câu 1: Trong bảng Người mượn dưới đây, hãy cho biết đâu là:
- Các tên thuộc tính
- Chỉ ra một giá trị thuộc tính
- Đưa ra thông tin đầy đủ của một bản ghi trong bảng.

Bảng Người mượn

	Số thẻ
	Họ tên
	Ngày sinh
	Lớp

	TV- 01
	Nguyễn Long
	1/11/1988
	12C

	TV- 02
	Hoàng Văn Oanh
	23/06/1989
	12A

	TV- 03
	Hồ Quảng
	12/09/1988
	12B



Câu 2: Khóa là gì? Trong bảng trên nếu có bạn đề nghị dùng bộ thuộc tính Họ tên và Lớp làm khóa, em có đồng ý với ý kiến đó hay không? Vì sao?

BÀI TẬP THỰC HÀNH SỐ 8
REPORT 

SỦ DỤNG CSDL Quanli_HS TỪ CÁC BÀI THỰC HÀNH TRƯỚC.
Bài 1: Từ bảng HOC_SINH trong CSDL Quanli_HS, tạo một báo cáo để in ra danh sách các học sinh gồm họ tên, ngày sinh, địa chỉ. Hãy nhóm theo giới tính và tính số học sinh nam, học sinh nữ.
· Mở CSDL “Quanli_HS”
· Nháy đúp vào Create report by using wizard.
· Chọn bảng HOC_SINH làm nguồn dữ liệu.
· Chọn các trường: Hoten, Ngsinh, Diachi, GT đưa vào báo cáo
· Chọn trường GT để gộp nhóm
· Sắp xếp tên theo bảng chữ cái
· Chọn cách bố trí và trình bày
· Đặt tên và nháy vào Finish
Sử dụng hàm Count để đếm HS nam và nữ. Thêm ô Text Box vào phàn chân nhóm (GT Footer) và nhập: So nguoi: =(Count([GT])


BÀI TẬP THỰC HÀNH SỐ 9 TỔNG HỢP
Bài tập 1: 
a) Từ Table:DANHSACH (HOTEN, TO,DIEM) 
HOTEN Text, 25 ký tự
TO Number, Integer (số nguyên)
DIEM Number, Single (số thực), lấy một số lẻ (Decimal place:1)
b) Nhập dữ liệu với nội dung sau:
c) Tạo Report  chứa tất cả các trường của table DANHSACH với yêu cầu sau:
-  Phân nhóm trên trường TO (Tổ giống nhau thì được xếp vào một nhóm)
- Trên mỗi nhóm lại sắp xếp tăng dần trên trường HOTEN
- Trên mỗi nhóm đã phân nhóm, tính điểm trung bình các HS trong tổ.
- Đặt tên Report là R_DANHSACH
Bài tập 2: Mở tệp KINHDOANH.MDB nằm trong thư mục My Document, gồm các bảng:
Nội dung các bảng :
Thực hiện các yêu cầu sau:
a) Dùng Query để lập danh sách phản ảnh quá trình mua hàng hóa của khách hàng, chứa các trường:  Ma_khach_hang, Ten_khach_hang, Dia_chi, và tạo trường mới Thành tiền (=So_luong*Don_gia). Đặt tên Query này là QTHANHTIEN1
b) Lập báo cáo (Report) phản ảnh tên khách hàng, mã khách hàng, địa chỉ, thành tiền với yêu cầu:
b1) Phân nhóm trên trường Ten_khach_hang, Sắp xếp giảm dần trên trường  Thành tiền, trên nhóm đã lập tính tổng thành tiền mà khách hàng đã mua. Đặt tên R_THANHTIEN1
b2)Phân nhóm (lần 1) trên trường Dia_chi, trên nhóm Dia_chi lại phân nhóm (lần 2) trên trường Ten_khach_hang, Sắp xếp giảm dần trên trường  Thành tiền, trên nhóm đã lập tính tổng thành tiền, giá trị trung bình , giá trị cao nhất, thấp nhất của thành tiền  mà khách hàng đã mua. Đặt tên

KIỂM TRA 15’ BÀI 1
CÂU HỎI; Kể tên các thao tác tạo lập cơ sở dữ liệu

KIỂM TRA 15’ BÀ2
sử dụng ascess làm  bài tập và thực hành 8 ( nộp file mềm qua email; hantt29822gmai.com)
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